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Open Source software is free software that is openly developed and reviewed. It can potentially be more desirable than 
proprietary freeware or proprietary commercial software because of the power given to developers and users to freely alter 
the code and recompile it in order to improve or repair the software. It is sometimes supported only by volunteers, but there 
are often ways to purchase support. The most well-known Open Source projects are Firefox, Linux and Apache, but there 
are office suites, games, email programs, servers, photo editors, web page editors, and other software available for many 
platforms.  

John LeMasney is the Manager of Instructional Technology at Rider University in Lawrenceville, NJ, where he helps fac-
ulty to integrate technology into teaching and learning effectively.He serves on the board of Linux Users Group in Prince-
ton (LUG/IP) as Chief Marketing Officer. For more information about John, go to: 
http://www.educause.edu/content.asp?page_id=750&ID=115869&bhcp=1  
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Coming Events: 
 

  
November 14—Doug Dixon on Introduction to Blog-
ging, Podcasting, Vlogging and RSS. 
December 12—Membership Party 
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About PPCUG 
 

General Meetings 
Second Monday of the month at the 
Lawrenceville Library, Alternate 
Route 1 and Darrah Lane. 
7:00 PM: Social Time / Tech Corner 
7:30 PM: Meeting comes to Order 
7:45 PM: Featured presentation 
 

For information about upcoming 
meetings or joining PPCUG, see: 

http://www.ppcug-nj.org 
or email us at: 

ppcug.nj@gmail.com 
(Please include “OK” in the sub-
ject line.) 
 

Board Meetings  
Board meetings are open to all mem-
bers.  Notice of an upcoming meeting 
will be posted on the web site.   
 

Board Members 
President: 
   Clarke Walker 609-883-5262 
Vice-President: 
   Tom Carman 732-828-6055 
Secretary: 
   Joe Budelis 609-921-3867 
Treasurer: 
   Paul Kurivchack 908-218-0778 
Members-At-Large: 

   Al Axelrod 609-737-2827 
   Vic Laurie 609-924-1220          
   Kim Goldenberg 609-631-9140   
   Sol Libes 609-520-9024 
 

Chairpersons 
Hospitality: 
   Bill Hawryluk 609-655-0923 
Member Records: 
   Paul Kurivchack 908-218-0778 
Newsletter Editor: 
   Clarke Walker 609-883-5262 
Program Coordinator: 
   Sol Libes 609-520-9024 
Web Master: 

   Joe Budelis 609-921-3867 
 

2005 Annual Dues 
Dues are $40 per calendar year with a 
mailed newsletter or $20 per year 
with online access to the newsletter.  
New members pay $3.25 or $1.75 per 
month times the number of months 
remaining in the current year. 

Minutes of the September Meeting 
 
Clarke started the meeting at 7:30 p.m. 
 
There were no questions from the audience. 
 
Clarke showed some Phishing Emails masquerading as PayPal Emails.   The criminals  
are getting more clever.  In this case they sent a phishing email in late July.  Then 
again in late August referencing the earlier email.  This made it seem more realistic. 
 
Chris Jarocha-Ernst arrived and began his “Creating Web Pages with Netscape Com-
poser” presentation at 8 PM. Chris has been at Rutgers for 20 years and he teaches 
Netscape courses there. Netscape is easy to use. However, since version 8 was re-
leased without Composer, to use Composer, you want to fully install version 7.2 
which you can do from http://browser.netscape.com/ns8/download/archive72x.jsp 
 
It installs in browser mode, but you can readily go to the Composer. To create a web 
page, go into Format, Select Page Properties and then Enter Text. Some options are to 
set heading category, set text color, page background color, and heading background 
color. You can insert an image. When you do so, you should set Alternate text for 
those persons using readers. You have options to change the image dimensions, to add 
links to images and to align text with images automatically. The ease of working with 
Tables is what Chris likes most about Composer. Although you can use the Web edi-
tor to avoid working with HTML code, Composer does give you an option to work 
directly with the source code. Under Insert there is a “Characters and Symbols” option 
that includes many characters and foreign accents. If you use one of the Microsoft 
programs to develop web pages, a lot of stuff is added that works only with Microsoft 
Server. From most points of view this additional code is a lot of junk. 
 
For existing web pages, in the Netscape browser, you can choose Edit page and Select 
Composer. Once your web pages are complete, you can find out from your ISP how to 
publish the pages. Netscape has a FTP protocol that can help you upload pages. Pages 
created by Composer usually display well in IE, Firefox and Opera. Firefox is the lat-
est evolution of Netscape. 
 
There is a Composer Tutorial at http://www.nbcs.rutgers.edu/education/composer/  If 
you have Composer questions, you can write Chris at Help@RCI.Rutgers.edu Men-
tion PPCUG and he will try to help. 
 
Nvu (www.nvu.com) is a new composer that is free; Chris has not yet investigated it. 

- Joe Budelis 
 

An attentive group listening to Chris Jarocha-Ernst. by Clarke Walker 
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President's Message 
 

Joe Budelis has indicated that he will not be able to continue as Secretary for the Club after this December.  The primary 
duties of the secretary is to take the minutes of the meetings and maintain the Yahoo e-mail list.  If you are interested in be-
ing the club Secretary please contact myself or any member of the Board. 
 
We are now seeking presenters for our Winter meetings.   Please contact Sol Libes (sol@libes.com) if you wish to make a 
presentation or have a topic to suggest. 
 

- Clarke Walker 
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Link of the Month 
 
The Open Source Initiative can be found at: http://www.opensource.org/ 
 
Have you discovered a useful link?  Then share it with the members of the P PC UG. 
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Recovery or Restore Disks 
 

by Vic Laurie, http://vlaurie.com 

Member of the Princeton PC Users Group 
  

 

Once upon a time you received a copy of a full Windows installation disk when you bought a computer. 
This allowed you to reinstall individual system files or Windows components if anything went wrong. 
But no longer. These days the best you can hope for from the major vendors is a so-called “recovery” or 
“restore” disk”. And many big vendors do not even provide that much. Instead they put stuff on a hid-
den partition on the hard drive. This is all the backup that you get, and if the hard drive crashes, the hid-
den partition goes too. Then you have no way of reinstalling Windows on a replacement hard drive 
without getting a disk from the original PC vendor  From what I read on the Web, this last process can 
take some time and effort (if you succeed at all). If you are out of the warrantee period, you may be 
completely out of luck. 
 
Some vendors may provide a Windows disk when you buy a PC if they are prodded hard enough. How-
ever, there may be some kind of “handling and shipping” fee. Note that, if you do finally get a disk, it 
will probably be an OEM (original equipment manufacturer) version and may lack some features of a 
full-fledged version. Also OEM versions of Windows are often not eligible for upgrades. 
 
The failure to provide an actual Windows installation disk with new computers is convenient for Micro-
soft and the computer vendors but can be a real problem for the PC user. There are many problems that 
can be fixed by copying a single system file or reinstalling small portions of the Windows operating sys-
tem. Without an installation disk, PC users need to have some other source for these files. If you put a 
recovery disk into your CD drive, it will want to reformat your hard drive and reinstall an image of your 
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computer that is a replica of the way your system was on the day you bought it. Any changes that you 
have made will be wiped out. All those programs you installed, all those Microsoft patches, XP SP2, all 
of it will be gone. The same thing applies when you restore from one of those hidden partitions. 
 
Therefore, an alternative is needed. At the very least, a source of files for adding and removing Windows 
components and restoring corrupted files should be available. Sometimes the vendor will have put the 
Windows installation files in the root of your hard drive or in the Windows folder. In Windows XP look 
for a folder named “I386” (without the quotes). If you do have one of these folders, burn a copy to a CD 
for backup. This CD will not have all the functions of an installation CD since it will not auto-run nor 
will it boot. However, reinstallation can be initiated by clicking the file Winnt32.exe (assuming that you 
can get your system to boot). If you have a FAT32 disk and can use DOS, Winnt.exe is the appropriate 
file to access from a DOS boot disk. 
 
A problem is that you will have a disk that lacks any of the multitudes of patches and updates that will 
have come out since you bought your computer. Therefore, you need to "slipstream" with the XP SP2 
update. Slipstreaming is a way of merging updates with the original files so that everything is updated. 
This is not a quick job but it is worth doing. An excellent detailed step-by-step procedure is given at the 
Elder Geek site (http://www.theeldergeek.com/slipstreamed_xpsp2_cd.htm). If you can borrow a Win-
dows XP installation disk (almost any version will do) you can extract the image that is needed to make 
the CD bootable and add that to the disk. Details for using common CD burning software to do all this is 
given at the reference cited above. 
 
One more problem can be getting the Windows XP product key for your system. It may be pasted or 
written somewhere in the documentation that came with your computer. Be sure to make a permanent 
record of it. If you cannot find the product key, there are several free applications that will retrieve it 
from your system. One is ViewKeyXp (http://www.mvps.org/marksxp/WindowsXP/prodkey.php). An-
other is Keyfinder, which is available at http://www.magicaljellybean.com/ . Also, system information 
applications like Belarc Adviser (http://www.belarc.com/free_download.html) can reveal the key. 
 
At the end, you will still have something that provides backup only for the Windows operating system. 
Since I want to be able to restore everything, including software that I have installed, I prefer to spend a 
few dollars and use disk imaging software. It makes keeping up-to-date backups on CDs or other exter-
nal media very easy. Norton Ghost, BootIt Next Generation or Acronis True Image are all possible 
choices. 
. 
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Cool Free Download From Microsoft For Windows XP Users 

SyncToy v1.0 
by Sol Libes, sol@libes.com  

Member of the Princeton PC Users Group 
  

 

An easy-to-use, customizable application to help you copy, move, rename, and delete files between fold-
ers and computers.  If you have more than one computer this software helps you synchronize files and 
folders between multiple computers.  SyncToy can manage multiple sets of folders at the same time; it 
can combine files from two folders in one case, and mimic renames and deletes in another. Unlike other 
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applications, SyncToy actually keeps track of renames to files and will make sure those changes get car-
ried over to the synchronized folder. 
 
http://www.microsoft.com/downloads/details.aspx?FamilyID=e0fc1154-c975-4814-9649-
cce41af06eb7&DisplayLang=en 
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Screen Shots 

by David Garcia, http://littlebluepcclub.home.comcast.net/ 

President of the Little Blue PC Club, Northglenn, Colorado 
  

 

Have you ever wanted to print out what you see on your monitor screen? This is called a “Screenshot,” 
and there are several software packages on the market that allow you to do just that with various degrees 
of sophistication. If you don’t need that sophistication, you can easily use Windows to get a screenshot. 
Just follow these instructions: 
 
1. Press the Print Screen Key  (PrtScr) on the keyboard. 
2. Click Start, then click Run. 
3. Type “mspaint” (without the quotes) in the Run box and click OK. 
4. In Paint, click Paste in the Edit menu 
5. Click Print Preview in the File menu. If the screenshot is cut off, you may want to  change the  
printer setting to print in Landscape mode. 
6. Click Print and close Paint. You’re done! 
 
    You can also save the file if you like: 
1. Click “Save” in the File menu 
2. Browse to the folder you want to save the file in so that the folder name is in the “Save In” box. 
3. Type a file name for the screenshot; use JPG  in the “Save as Type” box and click Save. 
 
Article rights are reserved. This article may be reproduced, downloaded, disseminated, or transferred, for single use by non-
profit organizations for educational purposes, with attribution to David Garcia. Little Blue PC Club, Northglenn CO.  It 
should be unchanged and this paragraph included. Please e-mail David Garcia at littlebluepcclub@comcast.net when you use 
it, or for permission to excerpt or condense. 
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Fantasy Football 
 

by Wayne Steen, Pythagoras78@hotmail.com 

Contributing Editor, Q BITS, Quad-Cities Computer Society, Iowa 
  

Playing Fantasy Football allows you the opportunity to manage your own team of professional football 
players.  You begin by drafting your own team of players from across the NFL (National Football 
League). Then you receive points based on your players’ actual performance in NFL games. 
 
Have you ever thought that you could do a better job of running the Chicago Bears than the current 
management has been able to do?  Well, this is your opportunity to prove yourself capable of being an 
NFL owner (you will have to become a multimillionaire on your own). 
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There are many fantasy football leagues to choose from on the Internet.  For this article, I will be using 
the NFL’s official Fantasy Football League.  You can go to http://football.nfl.com to find out more about 
joining the Official Fantasy Football League. 
 
You can choose between two playing options.  The Fantasy Football game is for one player.  After you 
sign up, you will name your team and you are arbitrarily assigned to play in a league by NFL.com.  The 
League Manager product allows you to manage your own league of friends or co-workers. 
 
I strongly suggest you play a season as an individual player and then be a League Manager the second 
year.  Being a League Manager is a very time-consuming job and required experience playing Fantasy 
Football. 
 
The X’s and O’s 
First, you do not need to have been a football player to be successful playing Fantasy Football.  Plating 
Fantasy Football is a great way to learn about the great game of football.  If you have a friend or spouse 
who loves football, then ask him/her to help you with a Fantasy Football team.  It will help you under-
stand their passion for the game. 
 
Each league consists of 12 teams.  You will manage one of the teams.  You will play weekly against one 
of the other teams in your league. 
 
You can sign up for Fantasy Football 2005 until 11:59:59 PM on October 8, 2005.  NFL.com.  Fantasy 
Football is free to play. 
 
After signing up, you will then join a draft in which you will raft your team.  IF you are new to NFL 
football, then you may want to ask a friend/spouse who knows football to help you with the draft.  Last 
year I was very lucky and was able to draft Ben Roethlisberger as my quarterback.  Ben was the rookie 
quarterback of the year for the Pittsburgh Steelers. 
 
Each team has 14 players; therefore, you will have a fourteen round draft.  Then each week during the 
season, you will select a starting lineup of eight players from the 14 players on your team. 
 
The scoring system is too complicated to explain in the brief room I have for this article.  There is a de-
tailed explanation of the scoring system on the www.NFL.com Web site. 
 
The twelve-team league is divided into three divisions.  The winner of each division plus a wild-card 
team will meet in the playoffs. 
 
The division champion with the best win-loss record will play the wild card team.  The other two divi-
sion champions will play each other.  Then the two winners meet for the championship. 
 
If you win the championship of your league, the next season you will be eligible to play in a special win-
ners’ league.  I lost in the playoffs last year, so I cannot tell you much about the winners’ league. 
 
You can make weekly lineup changes and can trade players during the season.  This is where champion-
ships are won and lost in Fantasy Football!  Trading during the season is much more important in Fan-
tasy Football than it is in the real game.  You do not have to worry about salary caps and the financial 
aspects of the game of pro football when playing Fantasy Football. 
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Conclusion 

 
The grand prize is $5,000 and a free trip to Super Bowl XL in Detroit.  If you win the grand prize, you 
can take me along as your friend. 
 
For the first time players, I recommend that you subscribe to Fantasy Football Extra.  You can sub-
scribe to Fantasy Football Extra at the same Web site as NFL Fantasy Football. 
 
The Extra e-mail subscription keeps you up to date on NFL statistics and injuries.  It also provides 
some useful tips on drafting and trading players.  At the time this article was written, the Fantasy Foot-
ball extra e-mail subscription cost $34.95 for the football season. 
 
Fantasy Football is a national craze and is much easer on your wallet than online poker.  It is a great 
way to learn about the game of football. 
 
Once you get past your rookie year of Fantasy football, then I suggest you create your own league with 
friends or co-workers.  It is a great way to bring everyone together. 
 
Be careful out there!  The children are back in school.  Watch out for them, because they may not be 
watching out for you!! 
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Subscribing to Smart Computing Magazines 
 

We get credit for members and friends who subscribe to Smart Computing, PC Today, or Computer 
Power User.  For us to get the credit you must mention “Princeton PC  Users Group—Lawrenceville, 
NJ”  when you subscribe via their web site at https://www.smartcomputing.com/secure/membership.asp 
 
Note we are not the only “Princeton” in their list  so make sure you pick the right one. 
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** There is no restriction against any non-profit group using these articles as long as they are kept in context with proper credit given the 

author.  The Editorial Committee of the Association of Personal Computer User Groups (APCUG), an international organization of 

which Princeton PC Users Group is a member, brings their respective articles to you. ** 
 
 
 

All unattributed articles are solely the fault of the editor. 

 

 

 

 

 

 



 
 

Important October Meeting Notice 
 

Because the Lawrence Library is closed on the second Monday for Columbus Day we will 
meet on the third Monday.  This means the next meeting will be October 17, 2005.  
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Princeton PC Users Group 
PO Box 291 

Rocky Hill, NJ  08553 

 

 

Chris Jarocha-Ernst 

>>>>>>>>>>>>>>>> 

More pictures from the Septem-
ber meeting. 


